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1 Using this Manual

Notice to Users

This manual and the associated software Excel-Financial-Model (EFM) are supplied under
a license agreement and may be used only in accordance with the terms and conditions
of the licence agreement set out in detail here .

Read the legal disclaimer and the license agreement  carefully. The use of Excel-
Financial-Model constitutes your unconditional and irrevocable acceptance of the terms
and conditions of both the legal disclaimer and the license agreement. If you do not agree
to both, do not install or use EFM. The use of Excel-Financial-Model is irrevocably
conditional upon full and constant compliance by you with the terms and conditions of the
license agreement.

Excel-Financial-Model (Version: Classic Economy)

As Financial Modelling Videos has a policy of continual product improvement, the
information and data contained in this manual are subject to change without notice and do
not represent a commitment by the vendor. Neither the manual nor software may be
copied or reproduced in any form, in whole or in part, without prior written permission of
Financial Modelling Videos or Fimovi GmbH.

© Copyright 2021. Fimovi GmbH. All rights reserved.

This manual relates to the software:

Excel-Financial-Model (Classic Economy)

Version:

2.04.1001

Last update of this manual: 14 Jun 2021

8
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Offline Help File

We also offer our help files as eBook (Windows executable containing an embedded
viewer). Download the Windows eBbook help file here.

Additional Information

In addition to this manual the Excel-file contains a sheet named "Quick Start Guide" with
some introductory information. Furthermore we have added numerous explanatory notes
as cell comments. When a cell contains a comment, a small, red triangle is displayed in
the upper-right corner of that cell. The comment is visible when you hover over the cell
that contains the comment.

Where possible, data validation option of Excel has been used to prevent data input errors
and avoid miscalculations.

No information contained in this manual or software should be construed as legal,
financial, investment, accounting or tax advice, nor should it be considered a substitute for
such advice.

http://www.excel-financial-model.com/manual/CE/manual_EFM-CE.exe
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2 Legal Disclaimer and License Agreement

Legal Disclaimer

No information contained in this Software (as defined below) or obtained from Fimovi
GmbH or Fimovi should be construed as legal, financial, investment, accounting or tax
advice, nor should it be considered a substitute for such advice.

This Software is supplied under a license agreement and may be used only in
accordance with the terms and conditions of the license agreement set out below. The
use of this Software is conditional upon the irrevocable and constant compliance by
the user with the terms and conditions of the license agreement.

License Agreement

Application: This agreement applies to the commercial or registered/upgraded
version of Excel-Financial-Model (also referred to as “EFM” or “Software”), comprising
workbook, related files and supporting documentation.

License grant: Fimovi GmbH grants registered users, i.e. a company, entity or
individual, a license to use this Software on any compatible hardware product (PC,
notebook, smartphone, tablet), to which the registered user has exclusive or primary
access. “Use” means storing, loading, installing, executing or displaying the Software.

Ownership: The owner and copyright holder of the Software is Fimovi GmbH. The
granted license confers no title of ownership to the Software and should not be
construed as a sale of any rights to the Software. This license is not transferable to
any other company, entity or individual.

Copyright: The Software is protected by copyright law. You unconditionally and
irrevocably acknowledge that no title to the intellectual property in the Software is
transferred to you. You further unconditionally and irrevocably acknowledge that title
and full ownership rights to the Software remains the exclusive property of Fimovi
GmbH and you do not acquire any rights to the Software except as expressly set forth
in this license agreement. You agree that any copies of the Software will also contain
the same proprietary notices which appear on and in the Software itself.

Unauthorized Use: You may not modify the Software or disable any licensing or
control features of the Software. You may not use, copy, rent, lease, sell, modify,
decompile, disassemble, otherwise reverse engineer, or transfer the Software except
as provided in this license agreement. Any such unauthorized use shall result in the
immediate and automatic termination of this license agreement. The Software's
worksheet (“Fimovi”) and VBA routines must not be altered under any circumstances.
Registered users may make backups of the Software for backup purposes and for the
purpose of creating additional sets of projections.
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Limited Warranty: This software is provided on an “as is” basis. Fimovi GmbH
disclaims all warranties relating to this software, whether expressed or implied,
including but not limited to any implied warranties of merchantability or fitness for a
particular purpose. Neither Fimovi nor anyone else involved in the creation, production
or delivery of this software shall be liable for any indirect, consequential or incidental
damages arising out of the use or inability to use such software, even in the case that
Fimovi GmbH has been advised of the possibility of such damages or claims. The
person using the software bears all risk regarding the quality and performance of the
software. In no event shall any theory of liability exceed the license fee paid to Fimovi
GmbH.

Governing Law: This Agreement shall be governed exclusively by the laws of the
Federal Republic of Germany to the exclusion of the UN Sales Convention and the
conflicts of law rules.

Reserved Rights: Fimovi GmbH retains all rights not expressly granted here.

Trademarks Disclaimer

All product and company names are trademarks™ or registered® trademarks of their
respective holders. Use of them does not imply any affiliation with or endorsement by
them.

• Excel, Office and Windows are registered trademarks of Microsoft Corporation
in the United States and other countries. 

• Mac and Mac OS are registered trademarks of Apple Inc., registered in the U.S.
and other countries. 

• Adobe and Acrobat are trademarks or registered trademarks of Adobe Systems
Incorporated in the U.S. and other countries.

Copyright 2021. Fimovi GmbH. All rights reserved.

http://www.financial-modelling-videos.de
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3 About the Author and Financial Modelling Videos

About the Author

Dirk Gostomski, founder and CEO of Financial
Modelling Videos, has extensive experience in
the development and review of financial models.
Dirk has been building complex project and
operational models and valuating financial
models for a broad range of industries including
mining, infrastructure, and energy for more than
17 years. He is also engaged in developing and
reviewing corporate planning and budgeting
models for both established and start-up
companies.

Working as a consultant for SMEs and venture
capital firms - offering business planning,
financial due diligence and capital raising
services - the idea was born to develop and
provide flexible, easy-to-use and robust Excel-
based financial modelling tools. The primary
objective is to help entrepreneurs, senior
managers and investors create detailed financial
models to gain full visibility into all of the
assumptions, cash requirements, profitability,
scalability and the ramp-up of their respective
business. You need not fear the financial section
of your business plan, and you do not need an
MBA to get it right.

About Financial Modelling Videos

Financial Modelling Videos enables its customers to develop flexible and robust
financial plans and cash-flow models using Excel. The Germany based company
provides a broad range of financial modelling related services for clients across many
industry sectors.

Our financial modelling video training courses are “hands-on” with users learning
concepts by building Excel financial models from scratch.

Our templates and excel tools are designed and built to be flexible, future-proof, robust
and user-friendly.

http://www.financial-modelling-videos.de
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Our seminar and workshop training services, enable entrepreneurs, corporate clients,
and investors to apply best practices when developing financial models. These tools
support and enhance their business decisions, transactions and strategies.

What Financial Modelling Videos can do for you:

• Ready-to-use Excel tools and templates for corporate planning, budgeting,
valuation, cash-flow planning and project finance

• Development of tailor-made, individual models

• Model review, optimization and audit

• Seminars and workshops

Contact us

Financial Modelling Videos is offered by Fimovi GmbH.

Fimovi GmbH
Sandstraße 104
40789 Monheim am Rhein, Germany

Email: efm@excel-financial-model.com

Internet:  www.excel-financial-model.com

mailto:efm@excel-financial-model.com
http://www.excel-financial-model.com
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4 Getting Started

In this section you will learn how to load and use the Excel template file, remove
worksheet protection, how to use and modify cell styles and we will introduce you to the
general layout and structure of EFM.

4.1 Loading and Using the Excel-File

Loading and Using the Excel-File

Excel-Financial-Model has been developed for Excel 2007 (v12.0) and later for PCs
and Excel 2011 (v14.0) and later for Macs.

EFM does not work in any other spreadsheet software or application such as Google
Sheets, Numbers, or Open Office.

The file contains VBA code you must enable macros to use the tool with its full
functionality.

Important Note: You must always save Excel-Financial-Model files in the xlsm (macro-
enabled) file format. Saving the file in the xlsx-format removes all macros, and the file
will show errors and cease to function after a few days.

Before using Excel-Financial-Model for the first time, prevent all macros from running
by setting the Excel Trust Center macro settings to “Disable all macros with
notification”. When you open the file, however, if the workbook contains macros, you
are provided with an option, to allow the macros to run.

When loading Excel-Financial-Model, click on the “Enable Content” option (see
screenshot).

For even more security and convenience we have digitally signed the VBA code in
EFM. Please read next section on how to add Fimovi as trusted publisher.
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Click image to enlarge

Add Fimovi as trusted publisher - Digital VBA-Code Authentication

Digital Code Authentication in Excel - Assurance that VBA code has not been
modified

In EFM we have used and implemented a code signing certificate from the certified
signing authority SECTIGO (https://sectigo.com/). This guarantees that the
VBA/macro project created by Fimovi has not been changed or otherwise modified.

A Digital Signature (also known as a digital ID or certificate) is an electronic,
encryption-based stamp which can be used to identify the author of the macros
contained in a workbook. The certificate used by Fimovi is like a security tag, which
verifies that the EFM VBA projects are safe. 

http://www.financial-modelling-videos.de
https://sectigo.com/
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A) View more information about a security warning and the publisher

When Excel displays the Message Bar to warn you about potentially unsafe code in a
file, you can view more information about the code and the publisher before deciding
whether to trust the code or the publisher.

To view details about code and the publisher after a security warning

1. Select the File tab

2. In the Security Warning area, click Enable Content => Advanced Options

      In Microsoft Office Security Options, Office displays additional information about
the cause of the security warning, including any information about the publisher that is
included with the publisher's code.

B) Enable active content when the Message Bar appears
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When new active content (such as a signed macro or add-in) is in a file from a
publisher, the Message Bar appears with a shield icon, warning text, and the Enable
Content button. If you know the publisher is reliable, you can enable the active content.
By doing so, the file becomes a trusted document, but the publisher is not trusted.
We'll talk about designating a publisher as trusted next.

When you select Enable Content on the Message Bar the file opens and is a trusted
document.

C) Add Fimovi (EFM) as trusted publisher when the Security Warning appears

To add Fimovi as a publisher to the list of Trusted Publishers after a security warning

1. Open the EFM file from Fimovi.

2. Select the File tab.

3. In the Security Warning area, click Enable Content => Advanced Options.

4. In Microsoft Office Security Options, click Trust all documents from this publisher
(see below screenshot).

If you want to add a trusted publisher but do NOT currently have a security warning for
one of their apps, you can add them as trusted in the Trust Center (see below).

http://www.financial-modelling-videos.de
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D) Add Fimovi (EFM) to the list of trusted publishers in Trust Center

1. Open the file from Fimovi.

2. Click File => Options.

3. Click Trust Center => Trust Center Settings => Trusted Publishers.

4. In the list, select the Fimovi's certificate, and then click OK.

Accessing and Changing the Excel Macro Security Settings

We recommend to set macro security settings to "Disable all macros except digitally
signed macros"   

To access and change the Excel macro security settings proceed as follows:

In Excel 2007:

1. Select the main Excel menu (by selecting the Excel Logo or File menu on the top
left of the spreadsheet), and from the bottom right of this menu, select Excel
Options;

2. From the window that pops up, select the Trust Center Option, and from within
this, click on the “Trust Center Settings...” button;

3. From within the Macro Settings option, select one of the settings and click OK.

In Excel 2010 and later:

1. Select the File tab, and from this, select Options;

2. From the window that pops up, select the Trust Center Option, and from within
this, click on the “Trust Center Settings...” button;

3. From within the Macro Settings option, select one of the settings and click OK.
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Note

When you change your Excel macro security setting, you will need
to close down and re-start Excel for the new setting to take effect.

Starting the Excel File - Product Activation

Excel-Financial-Model is protected and has a built-in activation process that includes
an “Enter Serial Number” dialog that only appears when macros are enabled.

http://www.financial-modelling-videos.de
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Start your copy of Excel-Financial-Model by entering the serial number you received by
email during the order process.

Note: You can use the Software with your license data on any computer, laptop,
notebook, or device that has Excel installed (see minimum version requirements). The
drawback of this flexibility is, that you need to enter your license serial number each
time you open the file.

Tip

You can copy the serial number using Windows clipboard
(CTRL+C) from your order confirmation email or any other source
and paste (CTRL+V) it directly into the serial number box. In case
you experience any problems during the activation of the software,
contact our technical support via email at: efm@excel-financial-
model.com

4.2 Password for changing and editing worksheets

Password for changing and editing worksheets

All Excel-Financial-Model worksheets are password protected when supplied in their
delivery state.

Users are thereby prevented from accidentally moving, deleting, or corrupting important
data and formulas they contain, while not restricting the potential for expansion or custom-
tailoring.

However, by default, you can select and change unlocked input cells. Press the TAB key
to move between these unlocked input cells quickly.

Experienced users can remove the worksheet protection to change or edit formulas,
expand the model, or add diagrams, and so on.

1. On the Review tab, in the Changes Group, click Unprotect Sheet.

mailto:efm@excel-financial-model.com
mailto:efm@excel-financial-model.com
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2. If prompted, type the password “0000” to unprotect the worksheet.

Note

The Protect Sheet option changes to Unprotect Sheet only when a
worksheet is protected.

4.3 Financial Modelling and FAST Standard

Financial Modelling and FAST Standard

All our Excel-based financial models and tools, including Excel-Financial-Model, are
compliant with FAST modelling standard. The FAST standard is the most widely adopted,
independently administered financial modelling standard in use today.

The FAST acronym stands for Flexible, Appropriate, Structured and Transparent models.
The FAST Modelling Standard is a set of rules providing guidance on the structure and
design of efficient spreadsheets for financial models, including a common style platform.

Adopting this standard increases your productivity, reduces errors within your models, and
makes them easier to understand and review.

For more information visit www.fast-standard.org, where you can also download the latest
version of the standard in PDF format.

http://www.financial-modelling-videos.de
http://www.fast-standard.org/
http://www.fast-standard.org/
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4.4 Custom cell style set

Advantages of using cell styles

We consistently use cell styles throughout the whole Excel-Financial-Model allowing quick
and easy formatting. Professional cell styles enhance the presentation and readability of
the Excel-Tool for those not involved in its initial development and setup. These styles also
simplify ongoing model audit and add a level of consistency and professionalism.

The Excel-Financial-Model comes with a complete set of more than 40 distinct cell styles.
These styles have a proven track record in financial modelling and can be used for all
kinds of calculations and models. You can find a style guide on the “Formats” sheet of
the Excel-Financial-Model (see below screenshot).

Click image to enlarge

We recommend having at least a quick look at this style guide to familiarize with the most
common styles used in Excel-Financial-Model (Input, OffSheet Reference, Line Summary,
Line Closing, Empty Cell, etc.).

For all changes and enhancements to the model, we recommend the usage of the
predefined custom styles to maintain consistency and transparency. If needed, you can
quickly adapt each style according to your preferences, needs, or corporate design
guidelines (colors, fonts, number format, etc.) and they will update immediately throughout
the whole model.
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Application of a Cell Style

Before applying or changing cell styles, remove workbook password protection
(password: "0000").

To apply a Cell Style to one or more cells, highlight the cell(s) that you wish to format and
click on the Cell Styles button in the “Home” tab.

Tip: If you do not see the Cell Styles button, click "Styles", then click the "More" button
next to the cell styles box.

The box shown below appears.

Now simply choose the cell style which you want.

http://www.financial-modelling-videos.de
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Note

Sometimes it makes sense to use two cell styles in combination.
For example, you can combine one of the styles that only contain
the Number formatting attribute (Date, Number Standard, or Number
Percent) with another like Line Closing or Input (which contain all the
other formatting attributes except "Number" (“Alignment”, “Font”,
“Border”, “Fill”, or “Protection”).

4.5 Overview and Familiarization

To become familiar with the general layout and structure of Excel-Financial-Model, have a
look at the model flow chart and try adding or changing some of the supplied assumptions
in the example model. Click the sheet tabs to navigate through the model’s input sheet
and view the different calculation and output sheets.

For a better overview and quick navigation, the data in each worksheet is outlined
(grouped). Outline symbols are on the left side of the worksheet. You can display different
levels of data by using the mouse to click on the various symbols. To display rows for a
level, click the appropriate outline symbol (one, two, three, etc.). We recommend starting
by clicking “one”, which gives you a quick overview at the top level (everything collapsed).
To expand or collapse specific data in your outline, click the plus and minus outline
symbols.
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Click image to enlarge

The numbers outline the recommended order of planning steps in preparing a new model
(see next chapter  => Quick Start Guide).

http://www.financial-modelling-videos.de
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5 Quick Start Guide

The intent of this Quick Start Guide for Excel-Financial-Model is to get you up and running
with the tool and give you a brief overview of the most important steps and order of your
inputs (without reading the entire manual). It gives you an overview of a “recommended
planning procedure”. Further guidance and details on entering assumptions are in the
planning process  chapter.

How to build a new model

1. Open Excel-Financial-Model and save new file

To start constructing a new model, load the original (or a modified) xlsm-file and
immediately save it with an appropriate new file name.

2. Remove all existing assumptions and input data

As the original file comes with a fictive example planning, click the button „New
planning - erase all input data“ on the “Inputs” sheet. After running this macro (this
may take 20 to 30 seconds), you have an empty template.

3. Enter general model assumptions

Go to the “Inputs” sheet and fill in the general model assumptions. Important: Default
currency and denomination should not be changed later on as the input values
(currencies) will not be converted. Only the variable descriptions and unit descriptions
change accordingly.

4. Enter assumptions for products and services

On the “Inputs” sheet fill in descriptions for up to 10 different products or services,
corresponding input/output taxes (if applicable, otherwise choose zero rate), revenue
share per product and bad debts (both optional).

32

http://www.financial-modelling-videos.de
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5. Enter assumptions for human resources

On the “Inputs” sheet fill in names or position for up to 5 divisions (Direct Labor
Staff, Management & Administration Staff etc.). Note: Base salary has to be for 12
months, without income taxes or social insurance. The detailed staff planning (monthly
deployment schedule) will be covered later on the “Human Resources” sheet. Fill in
percentage for income taxes & social insurance and assumptions about “Other Staff
Costs” (optional).

6. Enter financing assumptions

Financing Assumptions should be entered at the end of the planning process since the
funding requirements depend on all the other input data. To avoid funding shortfalls
during the planning process, we recommend temporarily setting “Initial Equity” to a
very high number (e.g. 5 million) and set "cash-in at first month" to “NO” (details about
the funding waterfall in the financing chapter ).

7. Enter payment targets and tax assumptions

On the “Inputs” sheet fill in the remaining assumptions (payment targets and taxes).
These inputs can be easily changed at any time during or after the planning process.
Be aware that any change later on may have (positive or negative) effects on funding
requirements.

8. Enter assumptions for inventory planning and opening balance

If you would like to include detailed inventory planning, please activate corresponding
selection on the “Inputs” sheet. Profit & Loss items and Balance Sheet items can be
planned later on. The opening balance is optional. For “new” companies (foundations)
or projects leave input cells blank.

9. Enter Sales

Go to the “Sales” sheet and enter monthly sales quantities and prices. For each
product/service you have two input options, 1. Manual direct input and 2. Price
multiplied by quantity.

53
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10. Enter monthly personnel deployment schedule

Go to the “Human Resources” sheet and decide for each position/employee
whether social security contributions should be calculated and fill in monthly number
and availability (Direct Labor Staff will be planned separately later on).

11. Enter Cost of Materials/Packaging or Goods required and target
inventory

Go to the “Costs 01” sheet and enter cost of materials or goods required for each of
your product/service. There are 3 different planning methods available. You are free to
use one of them, two or all three at the same time.

If inventory planning is switched on (=> “Inputs” sheet) you can enter individual
inventory targets for each product as percentage of net sales.

12. Enter direct costs

Go to the “Costs 02” sheet to enter direct labor costs and other direct costs.
Planning logic for direct labor costs is the same as for other employees (=> “Human

Resources” sheet). For other direct costs variable descriptions (input cells) can be
changed.

13. Enter indirect costs (Overheads)

Go to the “Costs 03” sheet to enter all indirect costs. There are 5 different groups
(Management & Administrative, Operational, Sales & Marketing etc.). You can change
the variable descriptions (input cells) according to your needs. Note: Payroll costs are
directly linked from the “Human Resources” sheet (no input here).

14. Enter capital expenditures

Go to the “Capex” sheet to enter capital expenditures. You will find separate groups
for intangible, tangible and financial assets. There are also options for finance lease,
sale of assets and capitalization of company produced assets. For more details refer
to the capex chapter .51

http://www.financial-modelling-videos.de
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15. Enter financing assumption (final step)

Before going to the “Financing” sheet to fine-tune funding sources and structure,
enter tax advances (prepayments) on the “Inputs” sheet. Below the input row you
can see the actual amounts, calculated by the tool based on your inputs and
assumptions.

Back on the “Financing” sheet the drawdown of capital tranches is organized by a
default funding waterfall (aka "funding cascade"). After calculation of monthly funding
needs, equity will be used first, followed by different debt tranches and an overdraft
facility at the end of the cascade. See details in the financing chapter , for example
how to control and limit the various funding sources to optimize your funding structure.

Tip

To be on the safe side, be sure to save the model at regular
intervals (CTRL+S).

53
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6 Planning Process - Guidance on Entering Assumptions

This section offers detailed guidance on entering assumptions into the various sheets.
Any currency symbols and denominations are for illustrative purposes only.

Excel-Financial-Model contains many variables and features that may not be required by
all users. These can be left blank or filled with zero values. The entry of assumptions for
the opening balance is entirely optional and only makes sense for existing companies with
historical data.

Note: Assumptions should be entered only in dedicated, specially formatted input cells
(cell style “Input” or “Input_perm”).

Where possible, Excel's data validation option has been used to prevent data input errors
and avoid miscalculations. Some cells have a drop down arrow to select from a list of
options. In other cases there are error (stop) alerts when entering invalid data, indicating
which inputs are acceptable (only negative numbers, only integers between 1 and 12,
etc.).

The following sections give guidance on entering some important and critical assumptions
(self-explanatory assumptions are not covered here) as well as background information
where helpful. The sections cover each sheet in the recommended processing order (as
described in chapter "Overview and Familiarization ").

6.1 Sheet Inputs

General Model Assumptions

To start a new plan, click the "New Planning - Erase all input data" button (see macro
button in the screenshot below). This permanently clears all input data and cannot be
undone. If necessary cancel and save the workbook before continuing. This macro
operation can take 20-30 seconds to erase data across all sheets.

The input fields in the section "Names and Information" (“Legal Form” through “Last
Update”) are for information purposes only. The link to the cover sheet and the top of each
sheet.

24
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Language/Terminology

To be as flexible as possible, Excel-Financial-Model allows for changing between
UK/International or US/Canadian accounting formats and terminologies. The main
differences relate to spelling (labour vs. labor for example),  terminology (see table
below for examples), and the accommodation of taxes on sales, valued added (VAT)
and goods & services (GST).

Note: Printer page sizes (European A4 vs. US Letter) must be set individually within
Excel according to your needs.

Selected differences between UK/International and US/Canadian terminology:

UK / International US / Canadian

Profit & Loss (or P&L) Income Statement

Stocks Inventory

Debtors Receivables

Creditors Payables

This feature is implemented by using Excel’s CHOOSE function.

Syntax:   CHOOSE(index_num, value1, [value2], ...) 

with index_num being the named cell “language”. This argument can be 1 or 2. If
index_num (language) is 1, CHOOSE returns value1 (= UK Terminology); if it is 2,
CHOOSE returns value2 (US Terminology); and so on.

Example:  =CHOOSE(language;"Profit and Loss Statement";"Income
Statement")

Flexibility is high priority within Excel-Financial-Model, you may change the terminology
or add additional text as needed.

http://www.financial-modelling-videos.de
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Currency (code or symbol and denomination)

You can define different currencies codes or symbols (GBP or £, USD or $, EUR or €,
etc.) and denominations (1 or 000s). Currency inputs are independent of your
language settings (UK vs. US). We recommend the international standard three-letter
ISO 4217 currency codes (EUR, USD, GBP, AUS, etc.).

For more information:  http://www.iso.org/iso/home/standards/currency_codes.htm 

Note

Default currency and denomination should be defined at the
beginning of a planning process and not be changed later on as
input values (currencies) will not be converted. Only variable
descriptions and unit descriptions change accordingly.

Timing and Fiscal Year

In this section, enter a start date and the planning horizon. The start date has to be the
first day of a month. Otherwise, you will get an error message.

Fiscal Year

It is possible to define fiscal years (FY) which differ from calendar years (CY). In this
case use input cell “Last month of financial year” to choose a specific timing. In case
the input value is December (Month 12) fiscal year and calendar year are the same.
The terms “fiscal year” and “financial year” are synonymous. They both refer to an
accounting period of 12 consecutive months beginning on a date other than January 1.

However, to qualify for a different fiscal year, you must meet certain requirements,
depending on country-specific laws. We cannot give any advice at this point, as this
would go beyond the scope of this manual.

Tax year

A tax year is the accounting period you choose to calculate your income and expenses
for taxation purposes. In the current version of Excel-Financial-Model the tax year
always equals the fiscal year (i.e. if you set the last month of the fiscal year to
December => fiscal year = tax year = calendar year).

Planning Horizon

http://www.iso.org/iso/home/standards/currency_codes.htm
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Excel-Financial-Model allows for a maximum planning horizon of 5 Years (start year
plus max. 4 additional years). Depending on the start date and fiscal year you have
entered, the first year may be a short (less than 12 months) business year.

Note

It is possible to shorten the planning horizon at any time, even if you
have entered data for the full 5 years. All reports and tables reflect
figures within the selected time frame (= model life).

Products and Services

In this section basic assumptions regarding sales will be entered. For up to 10 different
products/services a description can be defined. These names will be used throughout the
complete model. However, the detailed monthly sales forecasts (quantities and sales
prices) for each product/service will be defined on sheet “Sales”.

Input/output taxes and Revenue Share

When using input/output taxes select the appropriate rate. In case you are planning
without VAT, GST or Sales Tax, set rate to “zero rate” for each product/service (for
more details on input/output tax settings see paragraph taxes => “VAT / Sales Tax
”).

In addition for each product/service a specific revenue share in percent can be
entered. The percentage of revenue entered here will go to the partner, agent, broker,
service provider, platform etc.

Allocation of other direct costs to products/services

 Some direct costs (direct operational costs on the “Costs 02” sheet) need to be
allocated to the appropriate product group to allow for product/service specific cost
and profit analyses. This can be done either on 

1. the basis of the corresponding direct payroll costs,

2. based on the relevant sales of the product/service groups, or

3. based on a manually set percentage distribution.

42
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Select the desired allocation basis via the drop-down menu (see screenshot). You can
change your selection at any time. For this allocation to work as indicated, direct labor
levels, sales, or percentage values need to be entered for each product/service group
used. If this is not the case, you may get an error message, because the automatic
allocation of the total direct costs is not possible.

Click image to enlarge

If there are neither direct labor nor sales projected for a particular month, you may get
an error message, because the automatic allocation of the total direct costs is not
possible. In this case, complete the missing data or change the allocation basis to
percentage distribution. You can set the specific percentage values for each
product/service in the "Allocation of other direct costs to products/services" section on
the "Costs 02" sheet.

Note

The informative value of direct cost allocation is dependent on your
inputs in one of the above sections (i.e. direct payroll costs, sales or
percentage distribution).

Bad Debts

You may optionally globally determine bad debts as a percentage of sales within this
input section. Sales receipts and input/output taxes (sales taxes, GST, VAT) are
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automatically adjusted to take the bad debt percentage into account. The cost of bad
debts is treated as an expense in the income statements (P&L).

Monthly sales forecasts (quantities and sales prices) for each product/service are
defined on the  “Sales” sheet.

Human Resources

This section covers basic assumptions regarding personnel expenses. Enter employee
names or clearly-identifiable descriptions for each position in up to 5 divisions (Direct
Labor Staff, Management & Administration Staff etc.).

Salary

Enter a base salary (for the first planning year) and an appropriate annual raise
(optional) for each employee/position. If necessary you can also overwrite formulas in
the years following the base year (see tip below).

Note: The base salary always refers to a period of 12 months (= annual salary),
without income taxes and social insurance, even if an employee is only expected to
work a few months of a year. Do your detailed staff planning (monthly deployment
schedule) on the “Human Resources” sheet.

Tip

If the annual raise does not fit your purposes it is possible to
overwrite calculated annual salaries for the years 2 to 5 with hard
coded numbers (see red marking in the screenshot above). In this
case the automatic percentage increase formula will no longer
function. We also recommend applying the cell style "Input" to
clearly indicate that an input value is necessary for the "new" cell(s).
Note: Remove worksheet protection  to enable editing.

20
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Social security contributions and taxes

Fill in a percentage (of base salary) for income taxes and social insurance. It is
possible to turn on/off the calculation of Social security contributions and taxes for
each employee/position on the “Human Resources” sheet.

Other Staff Costs

For each division assumptions for additional staff costs can be entered. Apart from the
first row item (“Recruiting Costs (one-time upon hiring)”) descriptions can be changed
according to your needs. Note: Pay careful attention to the units (column E) of each
row item (e.g. USD/FTE/month vs. % of base salary etc.). If you change a unit, the
formulas on the “Human Resources” sheet need to be edited accordingly
(recommended only for experienced excel users).

Financing

One of Excel-Financial-Model’s main USPs is its implied funding waterfall. This is an
ordered cascade of equity and debt draws with alternative funding priority.

As with modelling any cash flow waterfall, the process is expedited by calculating the
monthly deficit cash flow, setting up criteria for the maximum amount of equity and debt
that is still available for funding and making all calculations regarding fees, interest,
repayments etc. to get the associated balance sheets accounts.

The model consists of the following capital funding elements (= sources) which are used
in a defined order: Two equity tranches and (up to) five different debt tranches.

Equity

Initial Equity

For the first equity tranche (= initial equity) you have to decide whether the full amount
should go into the model in the first month (select “Yes”) or if you prefer a draw down
on an as-needed basis. In the latter case the amount entered in “share capital” can be
understood as maximum and may not be fully needed (if the total funding requirement
is less).



39
Planning Process - Guidance on Entering Assumptions

www.excel-financial-model.com

Additional Equity

For the second (optional) equity tranche (= additional equity) you can enter an amount
and the date the money will be made available (see above screenshot).

Note

We assume that both equity tranches are relevant for liquidity. In
case you have set up an opening balance , these amounts are
added to the share capital defined there. If there is no further
increase in share capital during model life (i.e. no equity funding),
leave these input fields blank.

Debt

Four different loans (debt tranches) and an additional automatic overdraft facility are
included in the funding waterfall.

Debt 1 to 4

The first loan (debt 1) is a fully automatic annuity. The regular payment interval
(interest & principal repayment) can be freely selected (monthly, bi-monthly, quarterly,
semi-annual, and annual). This debt can be switched on/off at any time by “one click”
and allows for automatic coverage of capital requirements up to the maximum debt
limit.

While using this mechanism you see the direct impact of any change in assumptions
on the capital requirement (e.g. when running different scenarios).

If debt 1 has been switched on you can enter the following assumptions:

• Facility description => goes through the full model and allows easy
identification (e.g. in balance sheet, etc.)

44
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• Maximum debt => limit for this tranche

• Drawdown Period => drawdowns are only possible during this period

• Tenor => period starts after drawdown period

• Grace period => (optional) “waiting period” after the end of the drawdown
period before repayment begins (interest calculated quarterly; not capitalized
in the model)

• Monthly interest payments during grace period can be switched on/off

• Interest and repayment interval => Options: monthly, bi-monthly, quarterly,
semi-annual, annual

• Interest rate

• Fees (upfront and commitment fee)

Click image to enlarge

Debt 2 to 4 are identical structured apart from their hierarchy in the funding cascade.
On the “Inputs” sheet, you can assign a facility description for each loan and decide
whether interest should be calculated automatically. In this case, enter an interest rate.
If you prefer to enter interest payments manually, enter them directly on the
“Financing” sheet.  You must always enter loan disbursement and repayments for
debts 2 to 4 on the “Financing” sheet.

Overdraft Facility / Current Account

For the current account, you can set up a maximum overdraft (set to zero or leave
blank if not used) and an interest rate. The overdraft facility comes at the end of the
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funding cascade. If liquidity is available, the model automatically uses it for highest
possible reduction of this “expensive” credit facility.

Other Assumptions

Payment Targets Debtors/Creditors

Excel-Financial-Model allows for detailed customization with regard to the payment
targets of debtors and creditors. For each product/service different payment profiles
can be defined (debtors / receivables). 

Note

You can distribute payments over a period of up to 4 months.
However, for any row the sum has to be 100%, otherwise an error
message will be displayed (in column J). The same is true for
creditors (payables).

Creditor payment profiles, set on the “Inputs” sheet, will only be used for cost of
materials/packaging and for goods required.

For all other cost items (for example, other direct costs or overheads) you can directly
enter individual credit periods (in months) in column F (on the "Costs 02" and "Costs

03" sheets) by entering integers from 1 to 4 (or 0 for immediate cash payment =>
same month).

http://www.financial-modelling-videos.de
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Taxes

a.) Taxes on Profit

As tax regimes are country specific and extremely heterogeneous, Excel-Financial-
Model has a straightforward implementation of tax calculation, which can be adapted
individually where necessary. On the “Inputs” sheet, a tax rate (in percent) and a tax
loss carried forward can be entered. The tax rate is applied to net profits before tax of
each fiscal year.

Advance tax payments can be entered for each planning year to straightening out cash
flow effects of a single annual tax payment. Prepayment dates are quarterly, and you
can set their exact timing (in months). In addition, you can define the date (month) for
the tax payment in the following year.

It is recommended to enter tax prepayments at the end or the planning process, as the
actual tax burden depends on numerous model assumptions and inputs. The row
below the input line for advance tax payments helps you choose appropriate amounts
for the prepayments, as it shows tax payable according to the model’s calculations.

b.) VAT/GST/Sales Tax

If no sales or input/output tax is applied, simply set rate 1 to rate 3 to 0%.

When using input/output taxes you can change the descriptive term according to the
appropriate country specifics. It is possible to choose between “Sales Tax”, “GST” for
Goods & Services Tax or “VAT” for Value Added Tax.

Define up to three different local input/output tax rates (besides a predefined zero
rate), e.g. a standard rate and one or two reduced rates.
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You can set different options for claiming and paying VAT/GST etc. Select an
accounting basis for claiming and returning your VAT/GST. The options are the invoice
or payments basis.

Invoice basis (aka imputed taxation)

Using the invoice basis, you account for VAT/GST at the end of the taxable period
when you issued an invoice to your customers or received an invoice from your
supplier. You will pay the amount of VAT/GST shown on the invoices you've given to
your customers (whether you've received a payment or not), and claim a credit for the
amount of VAT/GST shown on tax invoices you've received from your suppliers
(regardless of whether you've paid your supplier or not).

Payments basis (aka actual taxation)

Under the payments basis you account for VAT/GST at the end of the taxable period
when you make or receive the payment. This helps you manage your cash flow
because you only pay VAT/GST after you've received the payment from your
customers, and you only claim VAT/GST for the purchases and expenses you've paid
for.

Filing frequency / intervals

You can set the payment day interval when VAT/GST is paid to or refunded by
state/tax authority (filing frequency). Select one of the five options: 1. Monthly, 2. Bi-
Monthly, 3.Quarterly, 4. Semiannual or 5. Annual.

Finally, choose the rates applied for a.) cost of materials/packaging and goods and b.)
all other non-payroll expenses (other operating expenses, overheads etc.). If there are
items within these groups with mixed rates or if not for all positions input/output tax is
applicable enter a percentage of the amounts which are subject to VAT, GST, Sales
Tax etc.

Output tax rates for products/services have to be entered in the products and services
assumptions section .

Enter input tax rates for capital expenditures on the “Capex” sheet. Percentage and
tax rate can be set individually for each item.

Miscellaneous

1. For sources and uses calculation and overview (on summary 01 sheet), the
number of months to be calculated/shown, can be entered and changed at any time.
In case the number of months entered is longer than the model duration (based on
your timing assumptions), you will get a warning/error message.
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2. The interest rate for bank deposits (cash) can be set (interest receipts).

3. In addition you will find an option to switch on/off inventory planning  globally.

4. Finally it is possible to plan further P&L and Balance Sheet items (for example
extraordinary expenses, accruals, changes in advances received, advance payments,
etc.) Detailed input options can be found at the bottom of the “Inputs” sheet. The
table within the section “Miscellaneous” simply gives an overview of the figures on an
annual basis. It is formatted and integrated for (the optional) printing of the “Inputs”

sheet.

Opening Balance

For existing companies with a financial history, enter all the necessary initial values.
Check the control cell “balance check” just below the opening balance input cells, to
make sure the opening balance is balanced. If the control cell does not show “OK”, the
delta is indicated to help you review the values entered.

Click image to enlarge

For new projects or start-up companies with no initial values leave input fields blank or
set to zero.

47
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6.2 Sheet Sales

Sales Forecast

For each product/service two different options for sales planning are included in the
model. You can choose either one of them or even combine both methods to achieve an
appropriate forecast.

1. Direct Input:

Fill in estimated revenues for each month. It is also possible to use/insert formulas to
implement escalations or you are free to link in cells/rows from a more detailed,
separate calculation of your own (eventually integrated on a separated sheet or
section within your workbook).

Click image to enlarge

2. Price x Quantity:

As revenue for a given period is generally a result of price times quantity, you can
enter any sales quantities and net selling prices for all products/services and months.

Click image to enlarge

If you combine both methods for numerous products/services you may find it helpful to
have an overview of the totals at the bottom of the sheet. This summary will also be used
for the calculation of GST/VAT, taking into account optional bad debts.
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Note

All assumption values should be entered net of input/output taxes
(like VAT, GST or Sales Taxes)

6.3 Sheet Human Resources

Staff Planning

This sheet provides detailed staff planning (monthly deployment schedule). The
descriptions for employees/positions are derived from the “Inputs” sheet and can be
changed there.

You just have to decide whether social security charges (= SSC) shall be applied (YES or
NO => see red marking in below screenshot) and fill in the number of employees at the
desired period (months). This also allows for easy planning for instance in the case of a
reduction in staffing due to seasonal work or similar.

Click image to enlarge

All further calculations (wages & salaries, social security contributions & taxes, and other
staff costs) are performed automatically with no additional inputs required.

Note
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Direct labor staff will be planned separately on the “Costs 02”

sheet, as it will be assigned to the respective product/service (direct
costs).

6.4 Sheet Costs 01

Sheet “Costs 01” is dedicated to making inputs and providing calculations regarding:

1. Cost of materials/packaging and goods required as well as 

2. Inputs and calculations regarding the target inventory (stocks).

Cost of materials/packaging and goods required

The section cost of materials/packaging or goods required offers three different planning
methods for each product, which can be used either individually or in combination.

1. Direct Input: For each product, enter costs manually for each period (month)

2. Costs x Quantity: Quantities are linked from the “Sales” sheet. In addition, you
need to define the cost of materials/goods per unit for each period.

3. Percentage of Sales: Using this method you define a percentage of the sales of
the corresponding product. The “cost-of-sales ratio” (in percent) can be set
individually for each year to take into account cost reductions due to increased
production volumes, price advantages due to rising purchasing volumes, or other
factors.

Note

All assumption values should be entered net of input/output taxes
(like VAT, GST or Sales Taxes)

Inventory Planning

To activate the automatic inventory planning you must globally switch on this functionality
on the “Inputs” sheet. One can then enter an inventory target for each product. Target
input is in % of net sales of the given product.

http://www.financial-modelling-videos.de
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The resulting changes in inventory are calculated automatically for each product. The
actual changes may differ from the target value aimed for, if, for example, no sales are
planned for a month, the corresponding inventory cannot be reduced.

Example

If you would like to have inventory for a special product for a quarter and
your “cost-of-sales ratio” is 30%, you have to enter 90% (3 months x
30%) as inventory target.

The corresponding balance sheet account (Inventory/Stock (manufacturing &
merchandise)) for each product is on the “Costs 01” sheet. The initial values are the
input values defined in the "Opening Balance" section on the “Inputs” sheet..

Tip

To be even more flexible in inventory planning you are free to
overwrite the formulas in the row “Inventory target” of each product
(columns J to BU). You can either manually enter the required
values or use a formula to calculate for instance inventory for the
next x months based on your sales planning (see example and
screenshot below).

Assuming you receive (and pay for) materials only once per quarter,
put in the figures in the month of purchase and set the inventory
target for the following two months to zero. In this case, the model
reduces the inventory in month 2 and 3 accordingly, and won't effect
liquidity further during this period. You can implement numerous
other possible combinations and applications. We recommend
experimenting with this feature, using a new, almost empty planning
file to get a better feeling for the impact on inventory and liquidity (=>
keeping in mind creditor payment targets on the “Inputs” sheet).

The following screenshot shows a simple example. Assumptions: Sales quantity: 50
desktop computers per month; Sales price: EUR 1,000 each (set on the "Sales" sheet).
The assumed ratio of cost of materials to sales is 60%, i.e. EUR 30,000 per month. We
have replaced the formulas in row 128 (inventory target => columns J to BU) by input cells
(see applied cell style) and have set cell F128 to zero (cell style: empty cell). 

Now we can fine-tune inventory planning, for example purchase of material/goods only
once a quarter. In month 2 and 3 and 5 to 7 inventory is reduced accordingly (see balance
sheet account at the bottom of the screenshot). 
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Click image to enlarge

The situation is also correctly reflected in the corresponding P&L and Cash Flow
Statement (not shown here).

6.5 Sheet Costs 02

Sheet “Costs 02” is dedicated to making inputs and providing calculations regarding:

1. Direct labor and

2. Other direct costs.

Direct Labor

This section is similar in its structure and design to the “Human Resources” sheet.
Define how many employees are allocated as direct labor to each product. Assumptions
for the various positions (description, base salary, etc.) are derived from the Human
Resources section of the “Inputs” sheet.

Again, social security charges (SSC) can be switched on or off (YES or NO) for each
employee/position. Corresponding wages & salaries and also social security contributions
& taxes are calculated automatically with no additional inputs required.

Plan other staff costs for each product/service either as a percentage of the product
group’s base salary or by direct manual input (rows 233 onwards).

Other Direct Costs

Other direct costs include the different sub-groups:

1. Energy costs (of production & manufacturing),

2. Third-party services, and 

3. Various other direct costs.

http://www.financial-modelling-videos.de
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There are multiple input rows available. Variable descriptions can be changed (input cells).
Input values in column "F" allow for setting of individual credit periods (number of months).
Allowed input values are integers from 1 to 4 (or 0 for immediate cash payment => same
month).

Note

If you need more rows within these groups, simply insert additional
lines. However, don’t forget to add/link the newly inserted lines on
the “Debtors+Creditors” sheet as this defines the cash impact.

Allocation of other direct costs to products/services

The calculations that allocate "other direct costs" to the given products/services, allowing
for product/service specific cost and profit analyses, are further down the "Costs 02"

sheet.

You have to enter percentage values here only if you choose option 3  (allocation based
on a manually set percentage distribution) on the "Inputs" sheet.

Note

An error message shows, if the sum of all products/services is not
100% (see screenshot => column F).

35
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6.6 Sheet Costs 03

Overheads (indirect costs)

All operating expenses (overheads, indirect costs) of the company’s different divisions are
on this sheet.

Payroll costs are already linked in from sheet “Human Resources” (apart from block 5
“General Costs & Miscellaneous”). Multiple input rows are available for each section.
Variable descriptions can be changed (input cells). Input values in column "F" allow for
setting of individual credit periods (number of months => see below screenshot). Allowed
input values are integers from 1 to 4 (or 0 for immediate cash payment => same month).

6.7 Sheet Capex

All fixed asset assumptions and calculationson are on the “Capex” (capital expenditure)
sheet. The sheet handles three different categories of fixed assets:

1. Intangible assets,

2. Tangible assets,

3. Financial assets.

Within the tangible assets, there are three separate asset classes. You can change the
initial asset class descriptions (Land & Buildings, Plant & Machinery and Vehicles) as
needed. There is a summary of the three fixed assets categories at the bottom of the
“Capex” sheet.

The structure for each section (including six subsections A to F) is always the same:

http://www.financial-modelling-videos.de
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A - Purchases

Percentage and rate for input tax (VAT/GST etc.) are defined (if input/output tax is
applicable) in this section. In addition, amounts and disbursement scheme for new
investments items can be entered (excluding lease).

Note

Combine only similar assets in each subsection (i.e. with the same
useful life). They are summed up, and depreciation is only
calculated only for the total amount.

B - Amortisation/Depreciation

Enter the useful life (in months) and select whether straight-line depreciation should be
applied to the original cost (select “1”) or the double-declining-balance method for
accelerated depreciation (select “2”). Be sure that the method you select and apply is
legal in your country.

C - Company produced additions

This input row is for company produced assets which should be capitalized. Any
amounts entered in this row influence depreciation and the given balance sheet
account, but have no impact on liquidity. Be sure that any expenses (capitalized here)
are included/planned in other sections (like direct or indirect costs) where they affect
cash outflows.

D - Finance Lease

This subsection includes input cells for purchases financed by leasing, lease charges
(interest) and lease payments. These entries should refer to new finance and capital
leases only.
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E - Sale of Assets

Use these rows for disposals of fixed assets. Enter details of the proceeds, costs and
related accumulated depreciation. Profits/losses derived from the sale of fixed assets
are included in the income statements (P&L). Fixed asset and depreciation balances
are automatically reduced to take account of fixed asset sales.

F - Input tax on fixed asset purchases and leased assets

Input tax is calculated automatically according to your assumptions in subsection A.
No further inputs are required here.

The corresponding balance sheet account is at the end of each category. At the bottom of
the "Capex" sheet, there is a summary for all assets/asset classes.

6.8 Sheet Financing

Funding Waterfall

The “Financing” sheet is for funding input and calculations. The main section of the
sheet is related to the funding waterfall, an ordered cascade of equity and debt draws with
alternative funding priority.

In the top section (“cash before funding”) the monthly cash flow is calculated. Only in case
of a deficit, additional cash (= funding) is required (amount to be funded = uses).
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Click image to enlarge

The second section (“financing”) consists of the actual funding waterfall. The various
capital funding elements (= sources) are used in the following order: Equity first, followed
by debt 1 to 4 and in a final step the overdraft facility.

An error message indicating insufficient funding will show, if cash after funding (and
optional dividend payout) is negative.
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Click image to enlarge

Before you plan or optimize your funding structure you should finalize all other inputs
(sales, human resources, costs, and capex) and also fill in principal repayments and
interest payments for the debt facilities at model start (entered in the opening balance on
the “Inputs” sheet). Principal and interest payments for these liabilities can be planned
on the “Financing” sheet in rows 144 onwards. This is important as these payments
may influence your pre-funding cash.

Example

Let’s exemplify some options you have to optimize your financing
structure:

At the first stage of the funding cascade, you have several options. The full
amount entered on the “Inputs” sheet may come in in the first month (if
the corresponding option is selected), or on a cash-needed basis until the
maximum is reached.

If additional funds are required (subtotal < 0) the automatic debt 1 may
kick-in (if activated on the “Inputs” sheet). Be aware that two conditions
must be met for successful drawdowns. 1. There must be still capital
available for funding deficit cash flow (depends on your inputs regarding
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maximum facility limit); 2. The deficit must fall within the drawdown period
(depends on your inputs regarding drawdown period, both on the “Inputs”

sheet).

If additional funds are required (subtotal < 0) debt 2 can be utilized. Any
drawdowns can be entered manually in the corresponding input line. Enter
any repayments in the line below (as negative values). In case you have
selected automatic interest calculation no further inputs are required, if not,
manually enter interest payments (and financing fees, if applicable) below
the corresponding balance sheet account (row 114 onwards).

Debt 3 and 4 can be used in the same way. Last but not least the overdraft
facility will automatically try to fund any deficit cash flow left, provided you
have entered a maximum amount on the “Inputs” sheet and there is still
overdraft capital available.

Enter any dividend in line 75. An error message will show, if dividends exceed cash
available.

In case any debt repayments are financed partly or wholly by using the overdraft facility a
warning message will appear in the respective period (line 78). This is not an error in the
narrow sense, but in some cases, it is possible to shift repayments and therefore avoid
(further) drawdowns of the most expensive overdraft facility.
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7 Error Messages

The integrity of your model is vital in business. Users need to be confident in the figures
that are produced and do not want to spend time going through each of their formulas to
check for accuracy. The way Excel-Financial-Model overcomes this is an extensive
integration of checksums and sanity checks.

All model specific checksums (more than 30 different control cells => see below
screenshot) are consolidated in the integrity and error checks section at the bottom of the
"Inputs" sheet. This section is where you will be alerted of any errors anywhere in your
model workbook. An error produces a flag and the message “FAIL” in red in column
"H" (see screenshot).

Click image to enlarge
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How to solve problems with model integrity

The master integrity flag is linked to the header of every sheet. It indicates if any error
is preventing your model from calculating correctly. This helps ensure the maximum
integrity of your model. The screenshot below ("Sales" sheet), shows the master
model integrity indicating an error (“Fail”).

The following general procedure should help locate and eliminate errors:

1. Click on the link “Go to error checks”

This takes you to the integrity and error checks section on the “Inputs” sheet.

2. Pinpoint the location and description of the error in the table.

If there is more than one error message, solve one problem at a time.

3. Click on the appropriate link "To control cell".

This takes you to the calculation, causing the error

4. Locate and eliminate the cause by changing inputs or assumptions.

http://www.financial-modelling-videos.de
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8 Changing Excel-Financial-Model

One of Excel-Financial-Model’s main USPs is its flexibility and expandability. While many
users use EFM exactly as supplied, others may wish to take advantage of their Excel
expertise to tailor or extend it to meet specific requirements. This section gives some
general advice on changing the model. 

Note: If you have only minimal expertise with Excel or you need complex changes, we
provide individual customization services to deliver the exact solution you need. Contact
us using the form at the following URL:

  http://excel-financial-model.com/contact/

for any enquiries.

Some general advice

Some precautions and principles to keep in mind when changing Excel-Financial-
Model:

• When starting to change Excel-Financial-Model, always work from a copy of an
error-free version.

• Before editing any sheet, unprotect the worksheet (Password: “0000”)

• Never delete or alter the supplied range or worksheet names or interfere with the
macros supplied with Excel-Financial-Model.

• Whenever a model has been changed or extended, always fully test it (by using
positive and negative inputs, zero values or empty cells) to ensure that the changes
work as intended and have no undesirable or unexpected consequences.

• Having removed protection to make changes within a workbook, always restore
protection as soon as practicable to prevent a user from accidentally or deliberately
moving or deleting important data and formulas.

Inserting new worksheets

Adding new worksheets is a powerful way of expanding a model. It is both, user-
friendly and relatively unsusceptible to errors. This approach can be used for additional
output sheets as well as for more detailed input calculations, which are then plugged
(= linked) into the existing sheets.

http://www.financial-modelling-videos.de
http://excel-financial-model.com/contact/
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Extensions of simple formulas to plug into existing variables within Excel-Financial-
Model include the following:

• Inserting new worksheets to incorporate very detailed projections (see examples
below). These calculations can be summarized and plugged into the existing
sheets.

• Using Copy & Paste Special | Link to pull aggregated data from another Excel file
into Excel-Financial-Model.

• Copying & pasting values into existing assumption blocks or specifically designated
blocks below assumption reports.

The potential to expand Excel-Financial-Model in this way is effectively unlimited. For
example, detailed calculations of sales funnels for individual products, customer
acquisition, lists of materials, detailed cost analyses, capital expenditure schedules,
and much more.

In addition very detailed or specialized reports (e.g. for presentation purposes) could
be created with new diagrams, additional subtotals or with different levels of
aggregation and details. Another example of applying this technique could be the
construction of additional reports in foreign languages or currencies, which utilize the
same data as the underlying model.

By inserting additional worksheets containing these new reports laid out exactly as
desired and incorporating simple cell reference formulas to link back into cells within
existing Excel-Financial-Model calculations or reports. This approach is simple, less
error prone, and completely avoids the need to make any structural changes.

Avoiding calculation errors when making complex changes

When customizing and extending Excel-Financial-Model, it is important to ensure that
no calculation errors arise; that all checksums are correct, and that no imbalances
occur in the opening or projected balance sheets.

Because Excel-Financial-Model does not use floating values to balance its balance
sheets, it is very sensitive to formula errors. Consequently, all structural changes to
the model must be applied correctly. For example, if an additional cash flow related
item is introduced into the model as an assumption row, changes may be needed in
the income statement (P&L), cash flow and balance sheet output reports as well as in
their corresponding output reports on the “Summary 01” sheet (within the sources &
uses overview). In addition, corresponding changes may also be required in all the
quarterly and annual output reports (sheets “Summary 02” to “Summary 04”).
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For all changes and enhancements of the model we recommend the usage of the
predefined custom cell styles  to maintain consistency and transparency.

Note

Only very experienced users, familiar with both EFM and Excel,
should make these kind of extensions and structural changes. Make
a backup version of your file before beginning with complex
changes.

22

http://www.financial-modelling-videos.de
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9 Version History

This document provides a quick historical reference to Excel-Financial-Model versions,
release dates, features, and improvements.

Version 2.04 (Release date: 14 June, 2021)

· New: The regular payment interval (interest & principal repayment) of debt 1 (the
fully automatic annuity loan) can now be freely changed between monthly, bi-
monthly, quarterly, semi-annual, and annual.

· Revised: Interest payments during grace periods can now be switched on/off at any
time.

· New: For sources and uses calculation and overview (on summary 01 sheet),
number of months to be calculated/shown can be entered/changed on inputs sheet
(miscellaneous section).

· New: Digital Code Authentication. The VBA/macro code has been digitally signed by
Fimovi GmbH (= software developer). A Code Signing Certificate from the certified
signing authority SECTIGO (https://sectigo.com/) guarantees that the VBA/macro
project created by Fimovi has not been changed or otherwise modified.

· Improvement of selected formulas and formats.

Version 2.03 (Release date: 19 March, 2018)

· Fixed: File saving problems when using EFM with macOS High Sierra 10.13.2 and
Excel for Mac 2016 version 16.9 (180116). The problem only occasionally occurred
for Mac users after an update from Microsoft in January 2018.

Version 2.02 (Release date: 30 March, 2017)

· New assumption to select VAT accounting basis was added oh the "Inputs" sheet.
You can now choose between invoice basis (aka imputed taxation) and payments
basis (aka actual taxation).

· New bi-monthly interval added for filing VAT returns and associated payments
to/from the tax authorities.

· Improvement of selected formulas and formats.

Version 2.01 (Release date: 12 April, 2016)

· Initial version

http://www.financial-modelling-videos.de
https://sectigo.com/
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